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Năm học: 2020 – 2021

	
MÔN: TOÁN

A.  LÍ THUYẾT:
I. SỐ HỌC
- Ôn lại các phép tính với số nguyên, quy tắc bỏ dấu ngoặc, quy tắc chuyển vế.
- Kiến thức về phân số: Điều kiện để có phân số, hai phân số bằng nhau, tính chất cơ bản của phân số, rút gọn phân số ,phân số tối giản, quy tắc cộng, trừ nhân, chia hai phân số và tính chất.
- Kiến thức về hỗn số, phân số thập phân, số thập phân, phần trăm. Cách viết các dạng số đó dưới dạng phân số và ngược lại. 
- Các bài toán: Tìm giá trị phân số của một số cho trước. Tìm một số khi biết giá trị một phân số của nó. Tìm tỉ số của hai số.
II.HÌNH HỌC:
-  Các khái niệm: Nửa mặt phẳng, góc, tia phân giác của một góc, đường tròn, tam giác, cung tròn, dây, bán kính, đường kính, góc vuông , góc nhọn, góc tù, góc bẹt, hai góc phụ nhau, kề nhau, bù nhau, kề bù.
- Các tính chất: Tính chất cộng góc, tia nằm giữa 2 tia, tia phân giác của một góc.
B. BÀI TẬP
I. SỐ HỌC
Bài 1: Rút gọn:







a) ;	b) ;	c) ;	d);	e) ;	f) ; g) .
Bài 2: So sánh các cặp phân số sau:










a)  và ;	b) và ;		c)  và ;		d)  và ; 	e)  và .
Bài 3: Thực hiện phép tính, tính nhanh nếu có thể:
	
a) ;	 

b) ;	


c) ;    d) 

e)       
	

f) ;	

g) ;  	

h) 

i) ;         


k) 75% - 1+0,5:;
	
l) ;	

m) ; 

n) 	

o) 125%.


Bài 4: Tìm x biết 
	

a)            b)

c) 
	
d) 

e) 

f) 
	
g) 

h) 

i) 


Bài 5: Một lớp học có 40 học sinh gồm 3 loại: giỏi, khá và trung bình; số học sinh trung bình chiếm 35% số học sinh cả lớp, số học sinh khá bằng[image: ] số học sinh còn lại.
1. Tính số học sinh khá và học sinh giỏi của lớp.
1. Tìm tỷ số phần trăm của số học sinh khá, số học sinh giỏi so với số học sinh của cả lớp.
Bài 6: Một xí nghiệp đã thực hiện 5/9 kế hoạch, còn phải làm tiếp 560 sản phẩm nửa mới hoàn thành kế hoạch. Tính số sản phẩm xí nghiệp được giao.
Bài 7: Trường có 1008 học sinh. Số học sinh khối 6 bằng [image: ] tổng số học sinh toàn trường. Số học sinh nữ khối 6 bằng [image: ] số học sinh khối 6.tính số học sinh nữ,nam của khối 6.
Bài 8: Số học sinh khối 6 của trường làm bài kiểm tra học kỳ hai môn toán, trong đó số bài đạt loại giỏi chiếm 50% tổng số bài, số bài loại khá chiếm [image: ] tổng số bài và còn lại 12 bài trung bình và yếu.Hỏi trường có bao nhiêu học sinh khối 6?
Bài 9: Một kỳ thi học sinh giỏi có tất cả 120 Học sinh dự thi, mỗi học sinh dự thi một môn, trong đó có:20% tổng số  thí sinh thi môn tóan, số học sinh thi môn tóan bằng [image: ] số học sinh dự thi môn anh , số còn lại là học sinh dự thi môn ngữ văn. Hỏi số học sinh dự thi môn ngữ văn chiếm bao nhiêu phần trăm trong tổng số thí sinh.
II. HÌNH HỌC


Bài 1: Trên cùng một nửa mặt phẳng bờ chứa tia Ox, vẽ hai tia Ot, Oy sao cho ,.
   a) Tia Ot có nằm giữa hai tia Ox và Oy không ?
   b) So sánh góc tOy và góc xOt.	
   c) Tia Ot có phải là tia phân giác của góc xOy không ? vì sao ?


Bài 2: Cho hai tia Oy, Oz cùng nằm trên một nửa mặt phẳng có bờ chứa tia Ox. Biết , .
    a) Tính số đo góc yOz.

    b) Vẽ tia phân giác Om của . Tính số đo góc xOm

    c) Vẽ tia phân giác On của . Tính số đo góc mOn.


Bài 3: Trên cùng một nửa mặt phẳng bờ chứa tia Ox, vẽ hai tia Oy, Oz sao cho ,.
1. Tính số đo góc yOz.
1. Vẽ tia Om là tia đối của tia Ox. Tính số đo góc zOm.
    c)  Tia Oz có phải là tia phân giác của góc yOm không ? vì sao ?


Bài 4:	 Cho hai tia Oy, Oz cùng nằm trên một nửa mặt phẳng có bờ chứa tia Ox. Biết , .
1. Tính số đo góc yOz.
1. 

Vẽ tia phân giác Om của . Vẽ tia phân giác On của . Tính số đo góc mOn.


Bài 5: Trên cùng một nửa mặt phẳng bờ chứa tia Ox, vẽ hai tia Oy, Oz sao cho ,.
    a) Chứng tỏ Oz là tia phân giác của góc xOy.
    b) Vẽ Ot là tia đối của tia Ox. Tính số đo của góc yOt.
Bài 6: Cho góc bẹt xOy. Trên cùng một nửa mặt phẳng bờ xy kẻ hai tia Oz và Ot biết số đo hai góc xOz và góc yOt lần lượt là 500 và 800.
1. Tính số đo góc zOt
1. Chứng tỏ rằng tia Oz là phân giác của góc xOt
Bài 7: Cho đoạn thẳng AB = 6cm. Hai đường tròn (A ; 4cm) và (B ; 3cm) cắt nhau tại hai điểm C và D. Đường tròn tâm A cắt AB tại P, đường tròn tâm B cắt AB tại Q
1. Tính AC, AD
1. Chứng tỏ rằng Q là trung điểm của AB. Tính độ dài PB, PQ
Bài 8: Cho 2 góc kề bù nhau góc xOt và góc yOt, biết góc yOt = 600
1. Tính số đo góc xOt?
1.  Vẽ phân giác Om của góc yOt và phân giác On của góc tOx. Hỏi góc mOt và góc tOn có quan hệ gì? Góc mOy và góc xOn có quan hệ gì?
Bài 9: Cho tia OI và OK là hai tia đối nhau. Hai tia OA, OB thuộc hai nửa mặt phẳng đối nhau bờ IK. Tia OI cắt đoạn AB tại I. Biết góc KOA = 120O, góc BOI = 60O.
1. Tính góc KOB ; góc AOI
1. Chứng minh góc KOA = góc KOB = góc AOB
1. Tia OK có nằm giữa OA và OB không? Vì sao?
III. PHẦN NÂNG CAO	
Bài 1:  Tính nhanh:


a) 		           e) 


b) 			 f) 


c)    	                      g) 


d) 				  h)
Bài 2: Chứng minh rằng:


a) ;				c) 


b)  < 1			d) 

Bài 3:  Tìm x, biết : 




Bài 5: So sánh     a)  và 		b) và 	


	MÔN: VẬT LÝ
I. Lý thuyết	
Câu 1. So sánh sự giống và khác nhau giữa sự nở vì nhiệt của các chất rắn, lỏng, khí?
Câu 2. Băng kép là gì? Hiện tượng gì sẽ xảy ra khi một băng kép làm từ đồng – nhôm được đốt nóng? Được làm lạnh? Nêu ứng dụng của băng kép?
Câu 3. Nhiệt kế là gì? Kể tên, nêu đơn vị đo nhiệt độ, nhiệt độ của hơi nước đang sôi và nước đá đang tan trong các thang đo nhiệt độ?
Câu 4. Định nghĩa và nêu đặc điểm của sự nóng chảy và sự đông đặc?
Câu 5. Sự bay hơi là gì? Sự bay hơi của một chất phụ thuộc vào những yếu tố nào?
Câu 6. Sự sôi là gì? Tại sao ta nói sự sôi là sự bay hơi đặc biệt?
II. Bài tập
Bài 1. Vẽ sơ đồ các quá trình chuyển thể? Trong các quá trình chuyển thể thì quá trình nào diễn ra ở nhiệt độ không thay đổi?
Bài 2. Tại sao mùa hè thường mưa nhiều hơn mùa đông?
Bài 3. Tại sao sấy tóc lại làm cho tóc mau khô hơn?
Bài 4. Tại sao sáng sớm ta thường thấy các giọt sương đọng trên lá cây nhưng khi đến trưa chúng lại biến mất?



	MÔN: TIN HỌC 

I I. PHẦN TRẮC NGHIỆM:  Khoanh tròn vào phương án đúng (A, B, C hoặc D)
Câu 1: Khi khởi động chương trình Word em có thể: 
A. Chọn Start→Run→Microsoft Word;		B. Chọn Start→Programs→Microsoft Excel;
C. Kích hoạt biểu tượng [image: ] trên màn hình nền;	D. Kích hoạt biểu tượng [image: ] trên màn hình nền.
Câu 2: Khi soạn thảo văn bản, các dấu ngắt câu: dấu phẩy, dấu chấm, dấu chấm phẩy, dấu hai chấm phải đặt:
	A. Sát vào từ đứng trước nó, tiếp theo là dấu cách nếu sau đó vẫn còn nội dung;		
B. Sau từ một dấu cách;		C. Sau từ hai dấu cách;		D. Không bắt buộc.
Câu 3: Để khôi phục thao tác vừa hủy bỏ em thực hiện :
A. Nháy nút lệnh [image: ];					B. Nháy nút lệnh [image: ];	
C. Nhấn tổ hợp phím Ctrl+B;				D. Không khôi phục được.
Câu 4: Để căn thẳng hai lề cho đoạn văn bản, sau khi lựa chọn đoạn văn bản, em thực hiện thao tác nào:
	A. Nhấn tổ hợp phím Ctrl+J;				B. Nhấn tổ hợp phím Ctrl+H;
	C. Nhấn nút lệnh [image: ] ;				D. Nhấn nút lệnh  [image: ].
Câu 5: Muốn tăng khoảng cách thụt lề cho đoạn văn bản, dung nút lệnh:
	A. [image: ]			B. [image: ];				C. [image: ];			D. [image: ].
Câu 6:  Các nút lệnh [image: ] lần lượt có chức năng:
	A. In nghiêng, gạch chân và căn thẳng lề trái; 	B. In đậm, gạch chân và căn thẳng lề trái; 
	C. In nghiêng, gạch chân và căn thẳng lề phải; 	D. In đậm, gạch chân và căn thẳng hai lề . 
Câu 7: Muốn đưa con trỏ soạn thảo vê đầu dòng, ta sử dụng phím nào: 
A. Page Up;		B. Page Down;		C. Home;		D. End.
Câu 8:  Để tìm phần văn bản, ta thực hiện lệnh:
A. Home→Find…;		B. Insert→Find…;	C. View→Find…;	D. Cả A, B, C đều đúng.
Câu 9: Để tạo bảng trong Word, ta dùng nút lệnh nào sau đây?
	A.  [image: ];		B. [image: ];			C. [image: ];		D.  [image: ].
Câu 10:  Đối với cột của bảng em có thể:
A. Xóa bớt một cột;					B. Chèn thêm một cột;	
C. Cả A và B đúng;					D. Không thể chèn thêm hoặc xóa cột của bảng.
Câu 11. Các tập tin soạn thảo văn bản trong Word có đuôi là:
A. DOC			 B. XLS		C. TXT		 D. BMP
Câu 12. Chức năng chính của Mcrosoft Word là gì?
A. Tính toán và lập bảng biểu.			B. Soạn thảo văn bản.
C. Tạo các tệp tin đồ hoạ.				D. Tạo các tập tin thực thi.
Câu 13. Khi in văn bản thì:	
A. Phải in nhiều trang.		      	   	B. Chỉ in được một trang.            
C. Phải in ra nhiều bản.		 		D. Có thể in riêng trang, trang chẵn hoặc trang lẻ.
Câu 14.  Để chọn hướng giấy in nằm ngang ta chọn vào ô:
A. Landscape			B. Left  		C. Portrait			D. Right
Câu 15.  Muốn tìm nhanh một  từ (hoặc dãy kí tự) em thực hiện:
	A. Home -> Find… 	B. Home-> Copy…		C. Home -> Paste…		D. Home -> Cut… 
Câu 16.  Tạo bảng  ta thực hiện: 
     	A. Insert\Table          	B. View\ Table        		C. Home\ Table       		D. Cả 3 đều đúng
Câu 17. Thao tác chèn thêm cột vào bên trái là:
A. Table Tools -> Layout -> Insert Below	           	B. Table Tools -> Layout -> Insert Above
C. Table Tools -> Layout -> Insert Right       	D. Table Tools -> Layout -> Insert Left
Câu 18. Để xoá thực sự các hàng, em sử dụng các lệnh sau:
	A. Table Tools\ Layout\ Delete\ Delete Cells		B. Table Tools\ Layout\ Delete\ Delete Columns
C. Table Tools\ Layout\ Delete\ Delete Rows	D. Table Tools\ Layout\ Delete\ Delete Table.
Câu 19. Để chèn hình ảnh minh hoạ vào văn bản, ta thực hiện:
A. File   -> Picture	B. Insert -> Picture	 	C. View -> Picture		D Home   -> Picture.
Câu 20. Muốn lưu văn bản, ta nháy nút lệnh nào sau đây trên thanh công cụ?
	A. [image: ]				B. [image: ]			C. [image: ]			D. [image: ]
Câu 21. Để đánh dấu chọn toàn bộ văn bản, ta dùng tổ hợp phím nào: 
     	A. Ctrl + B          		B. Ctrl + A          	C. Ctrl + U          	D. Ctrl + I          
Câu 22. Tác dụng lần lượt của các nút lệnh [image: ] là:
A. Chữ nghiêng, chữ đậm, chữ gạch chân.       	B. Chữ đậm, chữ gạch chân, chữ nghiêng.   
     	C. Chữ gạch chân, chữ nghiêng, chữ đậm.		D. Chữ đậm, chữ nghiêng, chữ gạch chân.
Câu 23. Công việc nào dưới đây liên quan đến định dạng văn bản?
     	A. Thay đổi phông chữ.	         			B. Thay đổi khoảng cách giữa dòng.     
C. Thay đổi kiểu chữ.         				D. Cả 3 câu trên.
Câu 24 : Trong Microsoft Word, chức năng của nút lệnh [image: ] trên thanh công cụ định dạng là:
       	A. Dùng để thay đổi tỉ lệ hiển thị văn bản	   	B. Dùng để thay đổi màu chữ
       	C. Dùng để thay đổi cỡ chữ	               		D. Dùng để thay đổi kiểu chữ
Câu 25 : Để tìm cụm từ lớp “Thăng Long” trong văn bản và thay thế thành “Hà Nội”, ta thực hiện:
A. Home  File	.				B. Home  Select.
C. Home  Replace.					D. Tất cả đúng.
Câu 26 : Để mở tệp văn bản có sẵn trong máy, em sử dụng lệnh nào?
	A. File/Cl.	     		B. File/New.           	C. File/Save.	    		D. File/Open
Câu 27: Khi muốn hình ảnh nằm bên dưới văn bản ta chọn cách bố trí nào sau đây?
A. [image: ]			B.  [image: ]		C. [image: ]		D. [image: ]
Câu 28 : Sau khi khởi động, Word mở một văn bản tạm thời có tên là?
A. Tạm thời       	B. Doc        		C. Document1 - Microsoft Word 	D. Word.doc
Câu 29: Khi soạn thảo văn bản trong các cách sắp xếp dưới đây, trình tự nào là hợp lí nhất?
A. Trình bày  chỉnh sửa  gõ văn bản  in ấn.	B. Gõ văn bản  chỉnh sửa  Trình bày  in ấn.
C. Gõ văn bản  trình bày  chỉnh sửa  in ấn.	D. Gõ văn bản  trình bày   in ấn   chỉnh sửa.
Câu 30 : Em sử dụng nút lệnh nào dưới đây để sao chép và dán văn bản?
	A. [image: ] và [image: ]	      		B. [image: ] và [image: ]            	C. [image: ] và [image: ] 			D. [image: ] và [image: ]

II. PHẦN TỰ LUẬN
Câu 1: Trình bày các bước để lưu văn bản vào máy tính.
Câu 2:. Trình bày các bước để di chuyển văn bản.
Câu 3: Định dạng văn bản là gì? Định dạng văn bản có mục đích gì? Nêu các cách định dạng kí tự mà em biết?
Câu 4: Tìm kiếm và thay thế là công cụ có chức năng gì? Nêu cách mở hộp thoại thay thế ?
Câu 5:  Nêu các bước cơ bản để chèn hình ảnh từ một tệp đồ họa vào văn bản.
Câu 6: Hãy nêu thao tác để tạo bảng biểu gồm 3 cột, 5 dòng bằng menu lệnh table trong chương trình Word ?
Câu 7: Trước khi in văn bản ra giấy, ta nên làm gì? Nêu thao tác in văn bản ?

III. PHẦN THỰC HÀNH: 
[image: Description: Top 7 Bài văn phân tích nhân vật Hồng trong đoạn trích “Trong lòng mẹ” của  Nguyên Hồng | Mỹ thuật, Hình ảnh, Vẽ người]Soạn thảo nội dung, chỉnh sửa, và định dạng trang văn bản theo mẫu, tô màu chữ theo ý thích, sau đó lưu lại trên ổ đĩa D với tên là: Tên em + Lớp (Ví dụ: BinhAn– lop6A1).
LÒNG MẸ
Những chiều khi nắng tắt bên sông
Màu tím hoàng hôn ngập cánh đồng
Tôi đón mẹ về nơi cuối xóm
Chợ chiều tan mẹ về bước thong dong.
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	STT
	Họ và tên
	Năm sinh
	Lớp

	1
	Hồ Thị Nhung
	18/08/1998
	6

	2
	
	
	

	
	
	
	


YÊU CẦU PHẦN THỰC HÀNH: 
- HS nhập đúng văn bản không sai lỗi chính tả 		- Định dạng nội dung văn bản đúng theo mẫu 
- Chèn được hình ảnh đúng theo mẫu			- HS tạo được bảng biểu 
- Viết và trình bày nội dung đúng theo bảng 		- Lưu văn bản đúng với tên đúng yêu cầu.


	MÔN: SINH HỌC


I. Trắc nghiệm
Ôn tập từ Bài 32: Các loại quả đến hết Bài 51: Nấm.
II. Tự luận
Câu 1: Phân biệt quả khô và quả thịt? Cho VD.
Câu 2: So sánh đặc điểm cấu tạo và sinh sản của cây thông và cây dương xỉ?
Câu 3: Cây trồng khác cây dại như thế nào? Cho VD.
Câu 4: So sánh điểm khác nhau của cây thuộc lớp 1 lá mầm và cây thuộc lớp 2 lá mầm? Cho VD.
Câu 5: Tại sao người ta lại nói “Rừng cây như một lá phổi xanh” của con người?
Câu 6: Cần phải làm gì để bảo vệ đa dạng thực vật ở Việt Nam?
Câu 7: Vi khuẩn có vai trò gì trong thiên nhiên và trong đời sống con người?



	MÔN: NGỮ VĂN

Ôn tập kiến thức đã học từ tuần 19 đến tuần 31 ( SGK Ngữ văn 6 tập 2)

A. KIẾN THỨC TRỌNG TÂM
Phần I: Văn bản
1. Văn bản truyện và kí:
- Bài học đường đời đầu tiên.
- Sông nước Cà Mau.
- Bức tranh của em gái tôi.
- Vượt thác.
- Cô Tô.
- Cây tre Việt Nam.
2. Thơ hiện đại:
	- Đêm nay Bác không ngủ.
	- Lượm.
3. Văn bản nhật dụng: Bức thư của thủ lĩnh da đỏ.
* Yêu cầu về văn bản
- Hiểu và trình bày được tác giả, tác phẩm, thể loại, hoàn cảnh sáng tác, phương thức biểu đạt, ý nghĩa nhan đề, tóm tắt truyện, bố cục, tình huống truyện, ngôi kể, thuộc thơ, mạch cảm xúc.
- Chỉ ra được nội dung, nghệ thuật, biết khai thác tín hiệu nghệ thuật trong tác phẩm văn học để làm nổi bật nội dung.
Phần II: Tiếng Việt
1. Các biện pháp tu từ : so sánh, nhân hóa, ẩn dụ, hoán dụ.
2. Các thành phần chính của câu. 
3. Các kiểu câu trần thuật đơn : câu trần thuật đơn có từ là, câu trần thuật đơn không có từ là.
4. Chữa lỗi về chủ ngữ và vị ngữ.	
* Yêu cầu về Tiếng Việt 
- Nhận diện được đơn vị kiến thức Tiếng Việt cơ bản trong văn bản.
- Nêu vai trò, tác dụng của các đơn vị kiến thức trong văn bản.
- Vận dụng kiến thức trong thực hành nói và viết.
Phần III: Tập làm văn
1. Miêu tả cảnh.
2. Miêu tả người.
* Yêu cầu về Tập làm văn:
- Vận dụng các kĩ năng quan sát, tưởng tượng, so sánh và nhận xét trong văn miêu tả.
	-  Biết được trình tự miêu tả và bố cục bài văn miêu tả.
	-  Biết vận dụng các kỹ năng đó vào tạo lập văn bản.
* Lưu ý : GV ra các dạng bài tập vận dụng kiến thức đã học vào việc giải quyết các vấn đề thực tiễn. 
B. MỘT SỐ DẠNG BÀI TẬP
Bài 1: Cho câu thơ: “Anh đội viên mơ màng”
a. Hãy chép tiếp 3 câu thơ để hoàn thành khổ thơ
b. Khổ thơ em vừa chép đã sử dụng biện pháp tu từ nào ? Nêu tác dụng
c. Câu thơ Bóng Bác cao lồng lộng – Ấm hơn ngọn lửa hồng đã tạo ra một hình ảnh vừa tả thực vừa lãng mạn, bay bổng. Em thấy ý kiến đó có đúng không ? Vì sao ?
Bài 2. Vì sao khi thức dậy lần thứ ba, anh đội viên lại hốt hoảng giật mình ? Em cảm nhận được tình cảm gì của anh đội viên dành cho Bác ?
Bài 3: Tìm từ láy có trong hai câu thơ “Bác vẫn ngồi đinh ninh – Chòm râu im phăng phắc”. Hãy nêu vai trò và tác dụng của các từ láy này trong việc miêu tả chân dung Bác
Bài 4: Chép thuộc lòng 2 khổ thơ cuối bài thơ “Lượm” của tác giả Tố Hữu. Theo em việc lặp lại đoạn thơ trên ở phần kết của bài Lượm có tác dụng gì ?
Bài 5. Chỉ ra câu thơ có sử dụng phép so sánh và cho biết vai trò, tác dụng của biện pháp đó trong việc tái hiện chân dung nhân vật Lượm.
Bài 6. Trong bài Lượm, tác giả dùng những từ ngữ : cháu, chú bé, chú đồng chí nhỏ để gọi Lượm. Hãy cho biết ý nghĩa và tác dụng của mỗi cách gọi.
Bài 7. Trong bài Lượm, tác giả có ba lần trực tiếp gọi tên Lượm : “Ra thế – Lượm ơi !…”Thôi rồi, Lượm ơi !”; “Lượm ơi, còn không ?”. Cách gọi ấy thể hiện tình cảm gì của tác giả đối với Lượm ?
Bài 8:  Đọc đoạn văn sau và trả lời các câu hỏi.
         Sau trận bão, chân trời, ngấn bể sạch như tấm kính lau hết mây hết bụi. Mặt trời nhú lên dần dần, rồi lên cho kì hết. Tròn trĩnh phúc hậu như lòng đỏ một quả trứng thiên nhiên đầy đặn. Quả trứng hồng hào thăm thẳm và đường bệ đặt lên một mâm bạc đường kính mâm rộng bằng cả một cái chân trời màu ngọc trai nước biển hửng hồng, y như một mâm lễ phẩm tiến ra từ trong bình minh để mừng cho sự trường thọ của tất cả những người chài lưới trên muôn thuở biển Đông. Vài chiếc nhạn mùa thu chao đi chao lại trên mâm bể sáng dần lên cái chất bạc nén. Một con hai âu bay ngang, là là nhịp cánh…
         a. Biện pháp tu từ nổi bật được sử dụng trong đoạn là biện pháp nào ?
         b. Hình ảnh mặt trời được tác giả miêu tả như thế nào trong đoạn văn trên ?
         c. Trình bày những cảm nhận của em về nghệ thuật miêu tả cảnh mặt trời mọc trên biển Cô Tô lúc hừng đông.
Bài 9: Trong bài Cây tre Việt Nam có nhiều hình ảnh so sánh. Hãy liệt kê các hình ảnh so sánh trong bài và nêu ý nghĩa, tác dụng của một hình ảnh so sánh mà em thích.
Bài 10: Chỉ ra biện pháp tu từ trong đoạn văn sau:
… Bóng tre trùm lên âu yếm làng, bản, xóm, thôn. Dưới bóng tre của ngàn xưa, thấp thoáng mái đình mái chùa cổ kính. Dưới bóng tre xanh, ta gìn giữ một nền văn hoá lâu đời. Dưới bóng tre xanh, đã từ lâu đời, người dân cày Việt Nam dựng nhà, dựng cửa, vỡ ruộng, khai hoang,…
Bài 11. Trong những ví dụ sau, đâu là ẩn dụ, đâu là hoán dụ?
a)
Ngày ngày mặt trời đi qua trên lăng
Thấy một mặt trời trong lăng rất đỏ.
(Viễn Phương)
b)
Xe vẫn chạy vì miền Nam phía trước
Chỉ cần trong xe có một trái tim.
(Phạm Tiến Duật)
c)
  Mặt trời xuống biển như hòn lửa
Sóng đã cài then, đêm sập cửa.
(Huy Cận)
d)
Vì sao Trái đất nặng ân tình
Nhắc mãi tên Người: Hồ Chí Minh.
(Tố Hữu)
Bài tập 12: Biện pháp nhân hóa được nhà văn Thép Mới sử dụng một cách hiệu quả trong văn bản "Cây tre Việt Nam". Em hãy tìm và phân tích tác dụng của một hình ảnh nhân hóa mà em thích nhất. 
	Ở đoạn cuối văn bản, tác giả đã tự tin khẳng định "tre sẽ còn mãi với các em, còn mãi với dân tộc Việt Nam...". Em có đồng tình với suy nghĩ của tác giả không ? Vì sao ?
Bài tập 13: Hãy miêu tả một người bạn mà em yêu quý
Bài tập 14: Hãy miêu tả một loài cây ( cây phượng, cây bàng, ...) mà em yêu.
Bài tập 15: Hãy miêu tả một người thân yêu và gần gũi nhất của em.
C. GỢI Ý TRẢ LỜI
Bài 1:
a. Học sinh chép chính xác khổ thơ theo Sách giáo khoa
b: Học sinh chỉ rõ nghệ thuật so sánh có trong khổ thơ và nêu được tác dụng gợi hình, gợi cảm 
c. 
- Học sinh cần khẳng định ý kiến có đồng ý hay không
- Dựa vào nội dung, ý nghĩa của câu thơ để giải thích rõ quan điểm của mình 
Bài 2. 
- Khi thức dậy lần thứ ba, anh đội viên lại hốt hoảng giật mình vì thấy Bác vẫn ngồi, không ngủ với tư thế như đang tập trung suy nghĩ một điều gì đó : ngồi đinh ninh, chòm râu im phăng phắc.
 - Tình cảm của anh đội viên dành cho Bác : yêu quý chân thành, lo lắng cho sức khoẻ của Bác
Bài 3: HS tự làm
Bài 4: 
- Sự lặp lại khổ thơ đầu ở phần cuối của bài thơ như sư trả lời cho câu hỏi “Lượm ơi, còn không ?”.
 - Đoạn thơ nhằm khẳng định Lượm – một chú bé liên lạc nhỏ bé, hiếu động, nhí nhảnh, vui tươi, hồn nhiên và rất đáng yêu – còn sống mãi với quê hương, đất nước, sống mãi trong lòng mỗi chúng ta. 
- Thể hiện tình cảm của tác giả (HS cần chỉ rõ)
Bài 5. 
- Câu thơ có sử dụng phép so sánh : Như con chim chích – Nhảy trên đường vàng.
- Phép so sánh này có vai trò quan trọng trong việc tái hiện chân dung nhân vật Lượm: chú bé liên lạc nhỏ bé, hiếu động, nhí nhảnh, vui tươi, hồn nhiên và rất đáng yêu. Hình ảnh đó còn góp phần tái hiện những bước chân tung tăng của Lượm (Vừa đi vừa nhảy!) trên đường.
- Hình ảnh so sánh Lượm với con chim chích – nhảy trên đường vàng thật đẹp, sẽ tạo cho người đọc những liên tưởng đẹp đẽ về Lượm.
Bài 6.  HS cần dựa vào ý nghĩa của từ, bố cục và nội dung từng phần bài thơ để nêu được ý nghĩa và tác dụng của mỗi cách gọi
Bài 7. 
- Trong bài Lượm, có ba lần tác giả trực tiếp gọi tên Lượm : “Ra thế – Lượm ơi !… “Thôi rồi, Lượm ơi !”; “Lượm ơi, còn không ?”. Cách gọi ấy thể hiện tình cảm thương yêu sâu sắc của tác giả đối với Lượm.
- Câu hỏi đứng riêng thành một khổ thơ. Mỗi câu lại một lần đảo ngữ và ngắt làm đôi thể hiện sự đau xót bất ngờ, sư nghẹn ngào trào dâng đọng lại trong lời tư hỏi. Câu thơ không chỉ nói lên tình cảm của nhà thơ với chú bé anh hùng ấy mà còn là câu thơ chuyển giữa hai đoạn thơ, giữa hiện tại và tương lai, giữa thực và mộng, giữa đau xót và niềm tin.
Bài 8:  
c) 
- Đoạn văn tả cảnh mặt trời mọc trên biển Cô Tô là bức tranh rất đẹp, rất nên thơ. Với Nguyễn Tuân, ngắm bình minh trên đảo là một cuộc đi tìm cái đẹp đầy công phu và sáng tạo.
- HS nêu cảm nhận cụ thể qua các hình ảnh nghệ thuật:
+ Hình ảnh so sánh chân trời ngấn bể như tấm kính lau hết mây hết bụi 
+ So sánh: Mặt trời tròn trĩnh phúc hậu như một quả trứng thiên nhiên đầy đặn 
+ Vẻ đẹp kì ảo của mặt trời lại làm người đọc ngạc nhiên khi biển là mâm bạc đường kính rộng bằng cả chân trời màu ngọc trai nước biển hửng hồng đặt trên đó là một mặt trời đẹp đẽ, hùng vĩ như quả trứng hồng hào, thăm thẳm và đường bệ.
+ Gọi cảnh tượng đó y như mâm lễ phẩm tiến ra từ trong bình minh để mừng cho sự trường thọ của tất cả những người chài lưới trên muôn thuở biển Đông
Bài 9: Trong văn bản Cây tre Việt Nam có nhiều hình ảnh so sánh với những ý nghĩa khác nhau.
          Ví dụ :
          – Cây tre là người bạn thân của nông dân Việt Nam, bạn thân của nhân dân Việt Nam.
          – Giang chẻ lạt buộc mềm, khít chặt như những mối tình quê cái thuở ban đầu thường nỉ non dưới bóng tre, bóng nứa.
          – Như tre mọc thẳng, con người không chịu khuất.
          – Tre trông thanh cao, giản dị, chí khí như người.
          Chọn nêu ý nghĩa, tác dụng của một hình ảnh so sánh mà em thích (tuỳ chọn, nhưng phải giải thích được vì sao em thích hình ảnh đó).
Bài 10:  Dựa vào những kiến thức đã học về nghệ thuật nhân hóa, học sinh xác định rõ biệng biện pháp tu từ nhân hoá được sử dụng trong đoạn văn
Bài 11. 
- HS phân biệt ẩn dụ và hoán dụ (dựa vào khái niệm).
- Xác định ẩn dụ và hoán dụ trong những ví dụ:
a) Tác giả sử dụng phép tu từ ẩn dụ qua hình ảnh mặt trời trong lăng rất đỏ.
b) Tác giả sử dụng phép tu từ hoán dụ qua hình ảnh một trái tim.
c) Tác giả sử dụng phép tu từ ẩn dụ qua hình ảnh sóng đã cài then, đêm sập cửa.
d) Tác giả sử dụng phép tu từ hoán dụ qua hình ảnh trái đất nặng ân tình.
Bài 12 
- Hình ảnh nhân hóa: Gậy tre, chông tre chống lại sắt thép quân thù. Tre xung phong vào xe tăng đại bác. Tre giữ làng giữ nước, giữ mái nhà tranh, giữ đồng lúa chín
- HS lựa chọn một hình ảnh và nêu rõ tác dụng: 
- Dựa vào nội dung văn bản, ý nghĩa của cây tre và thực tế cuộc sống hiện nay, học sinh nêu quan điểm cá nhân và giải thích rõ quan điểm của mình.
Bài 14
A. Mở bài :
- Giới thiệu loài cây định  tả.
- Tình cảm của em với loài cây đó
B. Thân bài
- Tả bao quát
- Tả những đặc điểm tiêu biểu của loài cây.
+ Thân
+ Rễ
+ Cành
+ Lá
- Kể kỉ niệm gắn bó với cây.
c. Kết bài
- Khẳng định tình cảm với loài cây 
Bài 15:
a. Mở bài :
- Giới thiệu khái quát người được tả
- Tình cảm của em với người đó
b. Thân bài :
- Lần lượt miêu tả những đặc điểm nổi bật của người được tả để làm rõ tính cách, phẩm chất tốt đẹp của người đó
+ Tả ngoại hình:hình dáng, đầu tóc, mặt mũi, da dẻ...
+ Tả tính cách qua hành động, cử chỉ, việc làm
+ Tả về sở thích, thói quen...
- Kỷ niệm đáng nhớ nhất của em đối với người thân.
c. Kết bài : 
- Tình cảm, ý nghĩ của em đối với người thân : tự hào, hành diện, thương yêu…
- Bài học và nhận thức của em: ghi nhớ tình cảm, nhắc nhở bản thân cố gắng học hành…


	MÔN: LỊCH SỬ

I. Nội dung ôn tập.
      Học sinh ôn tập những kiến thức Lịch sử đã học từ tuần 20 đến tuần 30, trọng tâm là những bài học sau:
- Chủ đề: Thời kì Bắc thuộc và các cuộc đấu tranh giành độc lập
- Chủ đề: Bước ngoặt lịch sử đầu thế kỉ X 
* Lưu ý: Chú trọng việc vận dụng kiến thức lý thuyết để giải quyết vấn đề trong thực tế.
II. Một số dạng câu hỏi và bài tập.
Câu 1: Trắc nghiệm khách quan (dạng câu hỏi lựa chọn một đáp án đúng).
Câu 2: Nêu nguyên nhân, diễn biến chính, kết quả của cuộc khởi nghĩa Lý Bí (542 - 543)? Sau khi đánh tan quân Lương, Lý Bí đã làm gì?
Câu 3: Nêu sự chuyển biến trong xã hội và văn hóa nước ta ở các thế kỉ I - VI?
Câu 4: Khúc Thừa Dụ dựng quyền tự chủ trong hoàn cảnh nào? Nêu những việc làm của chính quyền họ Khúc? Những việc làm đó có ý nghĩa gì?
Câu 5: Trình bày những nét chính về cuộc kháng chiến chống quân xâm lược Nam Hán của Dương Đình Nghệ (930-931)?
Câu 6: Trình bày diễn biến, kết quả, ý nghĩa của trận thủy chiến trên sông Bạch Đằng năm 938? Vì sao Ngô Quyền chọn khúc sông Bạch Đằng làm nơi bố trí trận địa cọc?
Câu 7: Câu hỏi vận dụng kiến thức giải quyết vấn đề thực tế
- Theo em vì sao Lý Nam Đế lại đặt tên nước là Vạn Xuân?
- Đánh giá vai trò, công lao của Ngô Quyền trong cuộc kháng chiến chống quân Nam Hán xâm lược lần 2.
- Trách nhiệm của học sinh khi đến tham quan khu di tích lịch sử Bạch Đằng và lăng Ngô Quyền?
- Giải thích lí do vì sao vùng đất Cổ Loa hai lần được chọn làm kinh đô của nước ta?
III. Gợi ý trả lời câu hỏi
Câu 1: HS ghi nhớ các mốc thời gian và sự kiện chính để trả lời. 
Câu 2: 
* HS trình bày theo kiến thức đã học ở bài 21.
* Những việc làm của Lý Bí sau khi đánh tan quân lương:
- Mùa xuân năm 544, Lý Bí lên ngôi hoàng đế (Lý Nam Đế).
- Đặt tên nước là Vạn Xuân, dựng kinh đô ở vùng cửa sông Tô Lịch (HN).
- Đặt niên hiệu là Thiên Đức.
- Thành lập triều đình với hai ban văn võ.
Câu 3: HS trình bày kiến thức theo nội dung mục 1 bài 20
* Những chuyển biến trong xã hội nước ta ở các thế kỉ I – VI:
 - Quan lại đô hộ: bộ phận thống trị xã hội
 - Địa chủ Hán: là người có quyền lực lớn trong xã hội
 - Địa chủ, quý tộc Việt: có thế lực ở địa phương và là lực lượng lãnh đạo các phong trào đấu tranh của nhân dân
 - Nông dân: được chia làm 2 bộ phận là nông dân công xã và nông dân lệ thuộc
 - Nô tì: là bộ phận thấp hèn nhất trong xã hội
* Những chuyển biến về văn hóa ở nước ta trong thế kỉ I – VI:
 - Mở một số trường dạy chữ Hán…
 - Đưa các tôn giáo và luật lệ người Hán…
 - Nhân dân vẫn duy trì phong tục tập quán chống  đồng hóa…
Câu 4: 
 * Hoàn cảnh  Khúc Thừa Dụ dựng quyền tự chủ: HS trình bày theo kiến thức đã học ở mục 1- bài 26(SGK).
* Những việc làm của chính quyền họ Khúc : HS chú ý đến đường lối xây dựng đất nước của Khúc Hạo.
- Xây dựng đất nước theo đường lối : Chính sự cốt chuộng khoan dung, giản dị, nhân dân đều được yên vui.
- Những việc làm cụ thể (Lấy dẫn chứng cụ thể theo kiến thức đã học trong bài 26, mục 1).
* Ý nghĩa :
- Nhằm xóa bỏ chế độ thống trị tàn bạo của nhà Đường, xây dựng một cuộc sống hoàn toàn tự chủ (Cuộc sống của người Việt hoàn toàn do người Việt tự cai quản, tự quyết định).
- Chứng tỏ nền đô hộ của các thế lực phương Bắc đối với nước ta đã chấm dứt, mở đầu giai đoạn chuyển tiếp sang thời kỳ độc lập hoàn toàn.
Câu 5: HS cần chỉ rõ nguyên nhân, diễn biến và kết quả của cuộc kháng chiến (Theo kiến thức đã học ở mục 2 - bài 26).
Câu 6: 
* Về trận thủy chiến trên sông Bạch Đằng năm 938, HS chỉ ra được:
- Diễn biến:
+ Cuối năm 938, đoàn thuyền chiến của quân Nam Hán do Lưu Hoằng Tháo chỉ huy kéo vào vùng biển nước ta.
+ Ngô Quyền cho một toán thuyền nhẹ ra nhử địch vào cửa sông Bạch Đằng lúc nước triều đang lên.
+ Hoằng Tháo thúc quân đuổi theo, vượt qua trận địa cọc mà không hề hay biết.
+ Nước triều bắt đầu rút, Ngô Quyền dốc toàn lực lượng đánh quật trở lại. Quân nam Hán chống cự không nổi rút chạy ra biển.
+ Đúng lúc nước triều rút nhanh, bãi cọc dần nhô lên. Quân ta từ thượng lưu đánh xuống, từ hai bên bờ đánh tạt ngang.
+ Quân Nam Hán rối loạn, thuyền địch va vào nhau vỡ tan tành. Hoằng Tháo bỏ mạng trong đám loạn quân.
- Kết quả:
Quân Nam Hán thua to, quân ta toàn thắng.
- Ý nghĩa: 
+ Là chiến thắng vĩ đại của lịch sử dân tộc.
+ Đập tan hoàn toàn mưu đồ xâm lược nước ta của các thế lực phong kiến phương Bắc, chấm dứt thời kỳ Bắc thuộc.
+ Khẳng định nền độc lập của Tổ quốc.
 * Ngô Quyền chọn khúc sông Bạch Đằng bố trí trận địa cọc (HS căn cứ vào nội dung bài học trả lời câu hỏi)
Câu 7: Học sinh tự liên hệ thực tế.
Gợi ý:
- Lý Nam Đế đặt tên nước là Vạn Xuân nhằm:
+  Thể hiện lòng mong muốn cho sự trường tồn của dân tộc, của đất nước.
+ Khẳng định ý chí giành độc lập của dân tộc, mong muốn đất nước mãi mãi thanh bình, tươi đẹp như vạn mùa xuân.
- Đánh giá vai trò, công lao của Ngô Quyền:
+ Huy động được sức mạnh toàn dân chuẩn bị cho cuộc kháng chiến.
+ Biết tận dụng được vị trí và địa thế của sông Bạch Đằng để đánh giặc.
+ Chủ động đưa ra cách đánh giặc và kế hoạch đánh giặc độc đáo: Bố trí trận địa cọc ngầm để tạo nên chiến thắng vĩ đại của dân tộc.
- Trách nhiệm của HS khi đến tham quan khu di tích lịch sử:
( HS có thể kể một số việc làm như giữ im lặng, lịch sự, không xả rác bừa bãi, tìm hiểu về khu di tích đó để giới thiệu cho khách du lịch...).
- Lý do Cổ Loa 2 lần được chọn làm kinh đô nước ta (Lần 1: dưới thời An Dương Vương, lần 2: dưới thời tiền Ngô vương):
+ Khi ấy, Cổ Loa nằm vào vị trí đỉnh của tam giác châu thổ sông Hồng và là nơi giao lưu quan trọng của đường thủy và đường bộ. Từ đây có thể kiểm soát được cả vùng đồng bằng lẫn vùng sơn địa. Cổ Loa là một khu đất đồi cao ráo nằm ở tả ngạn sông Hoàng.
+ Về phương diện giao thông đường thủy, Cổ Loa có một vị trí vô cùng thuận lợi hơn bất kỳ ở đâu tại đồng bằng Bắc Bộ vào thời ấy. Đó là vị trí nối liền mạng lưới đường thủy của sông Hồng cùng với mạng lưới đường thủy của sông Thái Bình. Hai mạng lưới đường thủy này chi phối toàn bộ hệ thống đường thủy tại Bắc bộ Việt Nam. 


	MÔN : ĐỊA LÍ 6
Câu 1: Các chí tuyến và vòng cực là ranh giới của những vành đai nhiệt nào? Nêu đặc điểm của đới khí hậu nhiệt đới?
Câu 2: Trong điều kiện nào, hơi nước trong không khí sẽ ngưng tụ thành mây, mưa?
Câu 3:
· Trình bày các khái niệm: Sông là gì?Lưu vực sông là gì? Hệ thống sông là gì? Phụ lưu là gì? Chi lưu là gì?
· Vẽ sơ đồ hệ thống sông?
· Trình bày khái niệm Hồ là gì? Có mấy cách phân loại Hồ? Nêu cụ thể các cách phân loại Hồ?

Câu 4: Cho bảng số liệu về lượng mưa ( mm) ở Thành phố Hồ Chí Minh.
	Tháng
 
	1
	2
	3
	4
	5
	6
	7
	8
	9
	10
	11
	12

	Lượng mưa
	18
	14
	16
	35
	110
	160
	150
	145
	158
	140
	55
	25


· Tính tổng lượng mưa trong năm
· Tính tổng lượng mưa trong các tháng mùa mưa( tháng 5- tháng 10).
· Tính tổng lượng mưa trong các tháng mùa khô ( tháng 11- tháng 4).

Câu 5: Quan sát bảng số liệu sau, hãy tính và so sánh tổng lượng nước (m3) của sông Hồng và sông Mê Công trong mùa lũ và mùa cạn. 
	
	Sông Hồng
	Sông Mê Công

	Lưu vực (Km2)
	143.700
	795.000

	Tổng lượng nước (Tỉ m3/năm)
	120
	507

	Tổng lượng nước mùa cạn (%)
	25
	20

	Tổng lượng nước mùa lũ (%)
	75
	80




	
MÔN: GDCD

I. Nội dung ôn tập: Ôn các bài từ tuần 19 đến hết tuần 30. Trong đó, trọng tâm kiến thức các bài sau:
- Bài 14 : Thực hiện trật tự an toàn giao thông
- Bài15:  Quyền và nghĩa vụ học tập 
* Lưu ý : Vận dụng các kiến thức đã học vào giải quyết các tình huống trong thực tế
II. Câu hỏi ôn tập :
Câu 1 : Pháp luật nước ta quy định như thế nào về quyền và nghĩa vụ học tập của công dân ?
Câu 2: Em đã thực hiện nghĩa vụ học tập của mình như thế nào ? Hãy tìm 2 câu ca dao, thành ngữ hay tục ngữ hoặc danh ngôn nói về học tập ?
Câu 3 : Quy định về an toàn đường sắt được pháp luật nước ta quy định như thế nào?
Câu 4: Để đảm bảo đi đường chúng ta cần tuân thủ những yêu cầu nào khi tham gia giao thông?
Câu 5: Pháp luật nước ta quy định như thế nào đối với người đi xe đạp khi tham gia giao thông
III. Bài tập: HS làm bài tập trong SGK vận dụng kiến thức lí thuyết vào giải quyết các vấn đề trong cuộc sống.
Bài 15 : Quyền và nghĩa vụ học tập
· Bài  c, d trong SGK trang 40
      Bài15: Quyền và nghĩa vụ học tập 
      - Bài tập a, b trang 38 SGK


	MÔN: CÔNG NGHỆ
CÂU HỎI ÔN TẬP

      Câu 1: Tại sao phải giữ vệ sinh an toàn thực phẩm?
Câu 2: Thực đơn là gì? Nguyên tắc xây dưng thực đơn ? Cho ví dụ 1 thực đơn cho bữa tiệc sinh nhật của em.
      Câu 3: Quy trình tổ chức bữa ăn gồm mấy bước?Đó là những bước nào? 
      Câu 4: Trong lớp hiện nay có nhiều bạn béo phì,theo em làm thế nào để giảm cân ?


	MÔN: TIẾNG ANH

* THEORY:
	1. Vocabulary:  related to the topics from unit 7 to unit 12
	2. Pronunciation:
		- Sounds: /Ɵ/ and /ð/; z/, /ea/ and /iə/, /əu/ and /ai/, /a:/ and /æ/,  /ɔɪ/ and /aʊ/. 
		- Word stress.
	3. Grammar:    + Conjunctions, word questions
		+ The past simple, imperative
		+ The present perfect tense, superlative adjectives.
		+ Will and modal verb “Might”
		+ Conditional sentences – type 1
		+ “Could” and “Will be able to” 
	4. Skills: Reading, Writing, Speaking
* PRACTICE EXERCISE: 
A. PHONETICS
I. Choose the words whose underlined part is pronounced differently from that of the others in each group
1. A. theater	B. there	C. through   	D. three
2. A. the	B. think	C. with	D. they
3. A. idea	B. reason	C. feature	D. teacher
4. A. fear	B. near	C. really	D. wear
5. A. motor	B. money	C. show	D. robot
6. A. prize	B.  excite	C. design	D. capital
7. A. afternoon	B. can	C. lack	D. animal	
8. A. party	B. glass	C. plant	D. plastic
9. A. opinion	B. open	C. robot	D. rose	
10. A. toy	B. join	C. voice	D. role
II. Choose the word whose main stressed syllable is placed differently from that of the other in each group.
1. A. schedule 	B. stupid	C. announce	D. reason
2. A. universe 	B. audience 	C. character 	D. entertain
3. A. career 	B. racket	C. regard	D. elect
4. A. marathon	B. equipment	C. fantastic	D. exhausted
5. A. journey	B. common	C. palace	D. award
6. A. pollution	B. continent 	C. Africa 	D. musical
7. A. special 	B. castle	C. wireless	D. cartoon
8. A. dishwasher 	B. bedroom 	C. computer	D. balcony
9. A. natural 	B. recycle	C. skyscraper 	D. universe
10. A. laundry 	B. minor 	C. reuse	D. robot
B. VOCABULARY AND GRAMMAR
I. CHOOSE THE BEST ANSWER
	1. _______ control is used to change the channel from a distance. 
		A. Distant 	B. Far 	C. Remote	D. Volume
	2. Weather _______ is my favourite TV programme because it prepares me for the weather on the next day. 
		A. prediction 	B. foresee 	C. guess 	D. forecast
	3. Lily and I have maintained a good ________ for 10 years.
		A. friend	B. friendly 	C. friendliness 	D. friendship
	4. My father is a very active _______ 
		A. cycle 	B. cyclist	C. bicycle 	D. cycling 
	5. K-pop has gained ________ in Vietnam in the recent years.
		A. popular 	B. popularly 	C. unpopular	D. popularity
	6. Keangnam, which is the tallest _______ in Vietnam, is a 72-storey building in Hanoi.
		A. skyscraper	B. sky building 	C. sky house 	D. skyline
	7. In some restaurants in China, waiters are now replaced by ______ because they are novel and fun.
		A. robots	B. machines 	C. devices 	D. tools 
8. A modem ___ can help keep your food fresh longer than the old ones.
		A. shelf 	B. kitchen 	C. fridge	D. cupboard 
	9. This washing machine is fully _______. All you have to do is put your clothes in and press these buttons.
		A. automate 	B. auto 	C. automatically	D. automatic
	10. I want to live in a house _______ the sea because I love the wind, the sand and the Sun there.
		A. in 	B. under 	C. on 	D. by
	11. We should use _______ shopping bag to protect the environment. 
		A. reusable	B. reused 	C. reusing 	D. reuse 
	12. Air ______ is a serious problem that our city is facing due to our own activities. 
		A. pollute 	B. polluted 	C. pollution	D. pollutant 
	13. ___ bags should be banned because the use of them pollutes our land and water seriously. 
		A. glass 	B. wooden 	C. garment 	D. plastic 
	14. Some people treat garbage by burning them, this will produce a lot of harmful ______.
		A. smoke	B. water 	C. fire 	D. steam 
	15. I and my classmates are ______ a survey on how much waste is produced at our school every day. 
		A. researching 	B. getting 	C. taking 	D. doing
	16. Although I only saw her once, I _______ her as soon as she came into the room. 
		A. recognize 	B. recognizing 	C. recognizable 	D. recognized
	17. The carpet at the front door is quite dirty, you should ____ it soon. 
		A. clean 	B. fold 	C. make 	D. lay
	18. My dog pet is absolutely intelligent, she can ______ and follow what I say easily. 
		A. understand	B. hear 	C. eat 	D. sit down 
	19. Cutting the ___ is one of my favourite things to do when I am in the garden because I can make the trees more beautiful. 
		A. hedge	B. trees 	C. flowers 	D. garden
	20. I don't think you should ___ the computer too much, your eyesight will get worse. 
		A. using 	B. use	C. used 	D. to use 
	21. People will ______ flying cars in the future.
		A. drive	B. to drive 	C. be drive 	D. driving
	22. _____ you _____ me your bike? I will ride it carefully.
		A. will/ to lend 	B. won't/ lend 	C. will/ lend	D. won't/ be lend
	23. In the future, we won't go to school by bus, but we ______ go to school by a magical door.
		A. might	B. are going to 	C. might be 	D. might not
	24. Our water bill ______ really high this month if you always forget to turn off the tap after taking baths. 
		A. will be	B. will is 	C. will not be 	D. will is not 
	25. If we ____ to go to school this afternoon, I and my friends will go to collect waste paper to create fund for the charity group. 
		A. have 	B. doesn't have 	C. don't have	D. do have 
	26. _______ you _______ hiking in the mountains if it rains tomorrow? 
		A. Will/go	B. Will/to go 	C. Do/go 	D. are/go 
	27. If you ______ absent from the most interesting English class today, you will miss one of the lessons ever. 
		A. will be 	B. shall be 	C. are	D. do be 
	28. ______ you hear the fireworks from your house last night? 
[bookmark: _GoBack]		A. Can 	B. Could	C. Do	D. Were able to 
	29. I’m afraid I _______ attend the festival next week, I am going to have final-term test in English. 
		A. won't be able to	B. can 	C. could 	D. will be able to 
	30. Neil Armstrong ______ set his foot on the Moon for the first time in 1969. 
		A. can 	B. was able to 	C. could	D. will be able to  
	31. ______ you be able to take part in the school prom next week? It will be really wonderful. 
		A. Could 	B. Can 	C. Will	D. Would
	32. Excuse me, ______ is the staff room?  I want to speak to Miss Lily. 
		A. When 	B. What 	C. Which 	D. Where
	33. George didn't want to get up late, ____ he set the alarm clock to go off at 6.30. 
		A. but 	B. and 	C. so	D. for 
	34. ____ of your classmates are going camping with you? 
		A. How often 	B. How much 	C. How many	D. How old 
	35. _______ the dog while we are away, Peter!
		A. Feed	B. To feed 	C. Feeding 	D. Fed
	36. I ______to the gym four times last week.
		A. was go 	B. goes	C. did go 	D. went
	37. The Sydney Opera House was designed ______ a famous Australian architect
		A. of 	B. by	C. as 	D. for
	38. Liza studies math ______ than Tom.
		A. good 	B. best	C. well	D. better
	39. Don't worry. I'm sure you ______ your driving test
		A. don't fail 	B. won't fail	C. won't fails 	D. won't to fail
	40. Venice is _______ beautiful city I have known.
		A. most 	B. the most	C. more 	D. the more
II. Choose the word or phrase that is CLOSEST in meaning to the underlined part in each of the foil owing sentences. 
1. Home appliances have changed very much during the past few years. 
		A. devices	B. toys 	C. machine 	D. furniture
2. The development of cities is becoming faster and faster and this causes wildlife animals’ homes disappear. 
		A. reason 	B. make	C. do 	D. purpose  
3. Everyone can save power by unplugging the home appliances when they’re not in use. 
		A. turn in 	B. switch on 	C. switch off	D. turn on	
4. I think robots now cannot do complicated things or communicate with people. 
		A. easy 	B. difficult	C. simple 	D. uncomplicated
5. One of the best things about robots is their ability to do jobs that would be just dangerous for people. 
		A safe 	B. risky	C. secure 	D. safety
III. Choose the word or phrase that is OPPOSITE in meaning to the underlined part in each of the following sentences.
1. My friend is given smart phone as a present on her 12th birthday
		A. quick	B. modern	C. old	D. stupid
2. Modern technology has now improved our life in all aspects.
		A. updated	B. advanced	C. outdated	D. new
3. Tigers, polar bears and giant pandas are among endangered species and need to be protected.
		A. saved 	B. conserved 	C. guarded	D. destroyed 
4. Our children and grandchildren might not have a green world to live in if we keep polluting the environment. 
		A. fresh 	B. clean 	C. dirty	D. friendly 
5. Baymax is a doctor robot in the film "Big Hero 6" and he is very intelligent and friendly. 
		A. nice 	B. kind 	C. lovely 	D. unfriendly
IV. Choose the underlined part that needs correcting in each sentence below.
1. Maria tried to read a novel in French, and the book was too difficult for her to understand.
	A. tried to	B. French	C. and	D. difficult
2. The food was delicious, but most things didn’t cheap.
		A. The	B. was	C. most	D. didn’t
3. Climbing Mount Fansipan were tiring, but very exciting.
		A. Climbing 	B. were	C. but 	D. exciting 		
4. The playwrights William Shakespeare is the most popular British writer in the world.
		A. playwrights	B. is	C. most popular	D. in the world   
5. Merlion is a creature with the head of a lion or the body of a fish.
		A. is 	B. with 	C. head 	D. or	
6. This summer I go to the beach with my family and friends.
		A. This summer 	B. go	C. with 	D. friends	
7. What will your mother does when she comes home from work?
		A. will 	B. does	C. comes 	D. from	
8. In the future, children won't not go to school and they will study at home.
		A. won't 	B. not go	C. will study 	D. at home	
9. Mai Anh thinks we might not go picnic on Sunday because it might rains.
		A thinks 	B. might not 	C. go picnic 	D. rains	
10. My dream house will have a swimming pool so I can do swimming every day.
		A. dream house 	B. will have 	C. so 	D. do swimming
11. I often went to a Korean restaurant for dinner with my Family.           
		A. went	B. Korean	C. for dinner	D. with
12. The weather in Dong Hoi City is the most driest in the region.
		A. The                        B. in Dong Hoi               C. most driest     	D. in the region
13. What does she go to school? – On foot.
		A. What      	B. does           	C. go                          	D. On foot	
14. We couldn’t hear the teacher because the students was very noisy.
		A. couldn’t	B. the teacher	C. was	D. noisy	
15. Tom won’t be able to working in the shed because he is ill.
		A. won’t be	B. working	C. because	D. is ill
V. EVERYDAY ENGLISH
1. _______ “The King of Football”?
	A. I don’t know	B. What’s that?  	C. What time?       D. Do you know Pele?
2. “How often are the Olympic games held?” _______	 
	A. Every four years.	B. Four years.	C. In 2009	D. Every year.
3. “I have been to Singapore _________. How about you?’	
			A. twice times	B. two	C. twice	D. two times
4. “Do you watch TV when you are eating?” - “________”
			A. Yes, sometimes.	 	B. I love watching TV. 
			C. It’s very interesting. 	D. I often watch TV.
5. “What kind of programmes do you watch most?” “________”
			A. Comic books.		B. I love watching cartoons so much.
			C. I like playing computer games.	D. I am interested in playing sports.
C. READING:
	I. Read and choose the correct answer. 
		People need to breathe. If they don’t breathe, they …(1)…….die. If they breathe (2)….. air, they will have breathing problems and become ill. Plants (3)…… animals need clean air, too. A lot (4)….. the things in our lives create harmful gases and make the air dirty. Dirty air is called “ (5)….. air”.
		1. A. will	B. are	C. must                	D. won’t
		2. A. clean	B. fresh	C. dirty                 	D. cool
		3. A. but	B. and	C. so                     	D. because
		4. A. in	B. of	C. on                    	D. about
		5. A. pollute	B. polluting	C. polluted           	D. fresh
II. Read the following text and answer the questions by choosing the option A, B, C or D  
My dream is to live in a big house surrounded by a big garden full of flowers and trees. I don’t like to live in an apartment with blocks of flats and rude neighbors making noise in the middle of the night. My future house will be located outside the city. It might be near a river. I have always dreamt of living near rivers and hearing the sound of the birds in the morning. 
My house will have a smart appliance which will monitor the current weather forecast to keep the temperature inside the house comfortable. It will use solar energy to heat the water; feed lights, computer, and other electronics. My future house will be an eco-house that uses clean energy to save the environment. 
It will have a large garden for me to have as many pets as I wish for. Then there will be some robots in the house to help me with my housework. They will clean the house every morning, prepare all the meals for me and feed the dogs and cats. 
	1. Where will the house be located?
		A. inside the river 	B. outside the city 	C. in the sky 	D. in the village 
	2. Why doesn’t the author like to live in an apartment?
		A. He/she doesn’t like to live in blocks of flats		       
		B. He/she doesn’t like the city
		C. He/she doesn’t like to live with rude neighbors		
		D. Both A and C are correct 
	3. Solar energy is used to ___________
		A. prepare meals		B. run the computers	
		C. cool the water		D. water the flowers
	4. Why does the author want to live in an eco-house? 
		A. to save energy 		B. so save the wild animals	
		C. to save the environment 	D. to save water
	5. What will the robots do?
		A. feed the pets	B. clean the house 	C. cook meal	D. All are correct 
D. WRITING:	
	I. Combine each pair of sentences below, using the words given
		1.We pollute the air. We have breathing problems. (If)
		_____________________________________________________________________
	2.It is raining very hard. We will cancel our picnic. (Because)
		______________________________________________________________________
	3.He was sick. He did the exam very well. (Although)
_____________________________________________________________________
	4. I want to have a park view in the front of the house. I want to have a mountain view in the back. (And)
_____________________________________________________________________
	5. Hoa went to class on time. She got up late (but)
_____________________________________________________________________
	6. We plant more trees. The air will be fresher.
		->If __________________________________________________________________
	7. We will use fewer cars. We will reduce pollution.
			->If __________________________________________________________________
	8. We cycle to school every day. We will keep fitter.
		->If __________________________________________________________________
	9. We will use recycled products. We will save money.
		->If __________________________________________________________________
	10. People throw rubbish into the right bin. They will keep the environment clean.
		->If __________________________________________________________________
	II. Rewrite these sentences, using the words given
		1. This is the first time I have seen an egg-shaped house. 
			->I have never_________________________________________________________
		2. They began watching the movie one hour ago.
 		->They have___________________________________________________________
		3.They have lived here for fifteen years. 
 		->They began__________________________________________________________
		4. She started driving 1 month ago.
			->She has_____________________________________________________________
5. We began eating when it started to rain.
		->We have____________________________________________________________
		6. Unless we protect the environment, we will destroy ourselves.
		->If__________________________________________________________________
		7. Unless she is more hard-working, she will get low marks.
		->If__________________________________________________________________
		8. If he doesn’t work hard, he will lose his job. 
		->Unless he___________________________________________________________
		9. If they aren’t visitors, they won’t be able to come in the zoo.
		->Unless______________________________________________________________
		10. No house in the area is more comfortable than the shoe- shaped house.
		-> The shoe- shaped house_______________________________________________
III. Make questions for underlined words.
		1. They are planting the trees in the garden.
_____________________________________________________________________
		2. My father will visit Ha Noi  next week.
_____________________________________________________________________
		3. She often watches TV at 6.45p.m .
_____________________________________________________________________
		4. We go to school every day.    
_____________________________________________________________________
		5. Tom and Mai will draw their dream houses. 	
_____________________________________________________________________
		6. My father was in Ha Noi last month.  
_____________________________________________________________________
		7. She left home  because she was sick. 
_____________________________________________________________________
 		8. My future house will be on the ocean.
_____________________________________________________________________
		9. She goes to the fitness center three times a week.
_____________________________________________________________________
		10.We will travel to the moon by a super car.
_____________________________________________________________________
E. SPEAKING
	Part 1 - Introduce yourself:
	- What your name? How old are you? 
	- Where do you live?
	- Which grade are you in?
	- What are your hobbies?
Part 2 – Topics:
	I. UNIT 10: OUR HOUSES IN THE FUTURE
	- What kind of house will it be? Where will it be? 
	- What does it look like? (villa/ apartment/ houseboat/ UFO/ penthouse…)
	- How many floors/ rooms will it have?
	- What will be there in your room?
II. UNIT 11: OUR GREENER WORLD
	- How many kinds of environment pollution do you know?
	- What are the causes for them?
	- What is the most popular kind of pollution?
	- What can be done to reduce it?
	III. UNIT 12: ROBOTS		
           - Image a robot of your own and describe it by these questions below:
		- What’s its name?
		- What does it look like?
		- What can it do?
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